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What is the WinActor Ver. 7 Series?

This is a completely new WinActor that is a remake of the WinActor Ver. 6 series. The Ver. 7 series further 

evolve and deepen the "field-friendly" concept, which is the most distinctive feature of the series, and 

pursue an RPA that is easy to use for everyone and can be adapted not only for beginners but also for 

advanced programmers.

Ver. 7.5.0 has the following features:

• Scenario Creating Guide 

• Scenario Creating with Generative AI 

• Scenario Editing Assistance 

• Improved Browser Operation 

• Python script execution

• Image Matching Property Improvement

• UI Automation Improvement

• Library Expansion

• Box Support

• Email Notification for Online License  

Registration
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New features1

This section describes the new features that have been added in Ver. 7.5.0.
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New function notation

This release note uses the following notation to explain the differences between licenses and functions.

FULL

Execut
ion

Manag
ement

When this notation appears, the function is available in the NL version.

When this notation appears, the function is available in the FL version.

When this notation appears, the function is available in the full-featured version.

When this notation appears, the function is available in the execution version.

When this notation appears, the function is available in the management-execution version.
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Scenario Creating Guide (1/3)

To make it easier for WinActor beginners to create scenarios,

we have added a scenario creation guide that allows you to create scenarios by 

simply following the guide.

FULL

From the “File menu”, 
select New.
Select New scenario with 
guidance.

Information 

getting Parts area

Simplified scenario edit 

area
Guide area

*For details, refer to the Operation Manual "1.19 Scenario creation with guidance"

Information 

setting

Parts area Drag and drop a part into the 
scenario edit area in the 
center, then create a 
scenario according to the 
guide message at the right.
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Scenario Creating Guide (2/3)

Guide messages appear one step at a time for each setting item, as shown below.

This helps you make the settings without getting lost.

FULL
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Scenario Creating Guide (3/3)

When you are finished, click the “Create the scenario” button in the lower right 

corner. Then, a valid scenario will be created. 

FULL
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Scenario Creating with Generative AI

In order to create WinActor scenarios with Generative AI,

we have added a function to create a model of scenario files using OpenAI or 

Azure OpenAI.

FULL

*In a proxy environment, please set it in advance from the "Proxy server" tab of the Option menu.

*To use this function, the user needs to create an account for OpenAI or Azure OpenAI.

Set in advance from 
the “Generative AI” 
tab in the Option 
menu.

Select [File] - [New]
Select [New scenario with 
generative AI)]

Enter the description of the 
scenario you want to create 
and click the OK button.

The model of the generated 
scenario may have some 
missing parts. 
Add or configure nodes as 
needed.

*The input of the user and the data created by WinActor are sent to OpenAI or a server providing Azure OpenAI services.

*For details, refer to "1.20 Scenario creation with Generative AI" in the Operation Manual (WinActor Operation_Manual).
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Scenario Editing Assistance (1/2)

In order to resolve scenario errors efficiently, if an error occurs during scenario 

execution, candidates in the scenario are suggested, which would ｒｅｑｕｉｒｅ 

correctionｓ.

FULL

Double-click the execution log to 
automatically focus on the node where 
the variable was last updated.

When an error occurs during scenario 

execution, the cause of the error may 

not be in the node where the scenario 

is running, but in the node that has 

been executed before.

In Ver. 7.5.0, when an error occurs 

during scenario execution, the 

location where the variable(used in 

the errored node) was last updated, 

will be output to the execution log.

By referring to this information, you 

can quickly find the source of the 

error and correct the scenario.
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Scenario Editing Assistance (2/2)

To efficiently modify scenarios after web page design is changed,

we have added a button to suggest XPath modifications when the web page is 

updated.

FULL

Even while the scenario is paused 
due to an execution error, you also 
can edit and update properties.
When an error occurs, you can select 
a new operation target using the 
Candidate button.

*The Candidate button will be activated if a proposal can be presented. For details, refer to the Operation Manual (WinActor Operation Manual) "3.8.5 Misc. tab, 

Table 3-56 No. 8" and the Browser Operation Scenario Creation Manual (WinActor_Browser_Operation_Scenario_Creation_Manual.pdf) "3.3. XPath ‘Candidate’ 

button."

The screen element will be highlighted, which is 
judged to be more appropriate as the modified 
XPath.
If you click the screen element in this state, the 
XPath of the target element is set to the 
property window.
If there are multiple choices, a series of numbers 
will be assigned in the judged order.

In the property window of 
the Browser Operation 
Library, click the Browser 
button, and then click the 
Candidate button.

*To use this function, a browser extension must be installed.
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Improved Browser Operation (1/2)

To enable more web windows operation, 

a CSS selector (Selector) has been added to the target element selection 

method for browser operation.

FULL Execut
ion

Manag
ement

If the Path type is set to 
Selector, the target element 
can be specified with a CSS 
selector.

*To obtain the Path of a CSS selector by using automatic recording or the Select button in the Property window, a browser extension must be installed.

By using automatic recording or the Select 
button in the Property window to select an 
element,

if the element cannot be specified by using 
XPath, Path type is automatically set to 
Selector. 

if the element can be specified by using 
XPath, Path will be acquired using XPath as 
before.
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Frame 0

Frame 1

Frame 2

Improved Browser Operation (2/2)

Individual browser operation libraries can be used to manipulate target elements 

while selecting frames. It is no longer necessary to use individual frame 

selection libraries to switch frames. Creation of scenarios involving browser 

operations becomes more efficient.

FULL Execut
e

Manag
e

①

②

③

④

①

②

③

④

Ver. 7.4 and 

earlier

Ver.7.5.0

Up to Ver. 7.4, 
it was necessary to 
perform "frame selection" 
every time a frame was 
crossed.

In Ver. 7.5.0,
you can select individual 
frame in each browser 
operation library.

Set a combination of "Frame  
selection mode" and "Frame 
Path."
For nested frames,
enter multiple Paths separated 
by semicolons’;’,

From automatic recording or 
the property window,
the Path of the frame will be 
automatically set.

*To obtain the Path of the CSS selector from automatic recording or the property window Select button, a browser extension must be installed.
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Python script execution

To enable a wider variety of tasks,

a new node for executing Python scripts is added.

FULL

*For details, refer to “3.14 Option Dialog, Table 3-122 Run tab of the Option dialog”, and "4.4.9 Run Python" in the Operation Manual 

(WinActor_Operation_Manual).

Execut
ion

Manag
ement

"Python execution" has been added to 
the Action category of the Node Palette.
You can use it by dragging and dropping 
like using other nodes.

The Python execution engine is built-in in 
WinActor.

If you want to use other engine, change the 
settings from the Run tab in the Option 
screen.
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Image Matching Property Improvment

To make the Image Matching node easier to use, the structure of the Property 

window is revised.

FULL

*The structures of the Propery window for the Contour Matching node and the OCR Matching node have also been revised. For details, refer to "4.4.1 Image 

Matching," "4.4.2 Contour Matching" and "4.4.3 OCR Matching" in the Operation Manual (WinActor_Operation_Manual).

In the initial display, only the basic 
settings are displayed.
Image Matching is enabled with the 
minimum settings.

You can expand the Image 
Matching area by collapsing 
setting area.

The Details tab allows you to 
make detail settings during 
operation. 
You can specify multiple files 
by specifying a folder in 
"Matching image path."

The Edit tab
allows you to change the 
image in the image 
specification area.



© 2024 NTT Advanced Technology Corporation 1414

UI Automation Improvement

A new control path specification method has been added, to make it easier to 

use automatic recording and scenario execution with UI automation.

FULL

*For details, refer to “4.9 ■ UI Automation property" in the Operation Manual (WinActor_Operation_Manual).

Execut
ion

Manag
ement

“Control Path Format Version” has been 
added to the Edit control path tab of 
the Property window.

In version 7.5.0, the new specification 
method "Version 2" is used by default,
when a new UI Automaton node is 
created (for example, in automatic 
recording).

If Version 2 does not work well, please try 
Version 1. 

Note that when you switch versions, the 
control path will be cleared.
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Library Expansion

To support more applications,

two browser operation libraries and the general-purpose socket communication 

library are added.

FULL

*For details on the browser operation library, refer to "5.7.17" and "5.7.18" in the Browser Operation Scenario Creation Manual 

(WinActor_Browser_Operation_Scenario_Creation_Manual). For details on the general-purpose socket communication library, see "99.4.1" in the Instruction 

Manual for User Library Samples (WinActor_User_Library_Sample_Manual).

Execut
ion

Manag
ement

SendMouseEvent emulates mouse 
operations for the target element.
Since it is emulated by JavaScript, 
the actual mouse pointer does not 
move.

MouseMove emulates moving the 
mouse over the target element 
(mouse hover).
Since it is emulated by JavaScript, 
the actual mouse pointer does not 
move.

Socket performs basic 
TCP communication using 
sockets.

*To execute the two new browser operation libraries, a browser extension must be installed.
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Box Support

To support file upload/download, searching and tag setting in Box,

Sub-scenarios are provided.

FULL

*In a proxy environment, specify settings in advance from the Proxy server tab of the Options menu.

Execut
ion

Manag
ement

*Set the Box app type to "Custom app" and the authentication method to "User authentication (OAuth 2.0)."

Before using sub-scenario, 
sign in to Box from Tools - Box 
sign In.

The redirect URI must be set the same as the OAuth 
2.0 redirect URI on Box.

In addition, the URI must be a loopback address that 
WinActor can receive, and a candidate URI will be 
presented when a dialog is displayed. Use it to set 
up Box.You can use them from 

04 _ Box category on the 
Sub Scenario palette.

*For details, refer to "3.2.3 Tool Menu, Box sign in" in the Operation Manual (WinActor_Operation_Manual) and "4 Box" in the Sub Scenario Sample Manual 

(WinActor_Subscenario_Sample_Manual).
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Email Notification for Online License Registration

In the same way as on the license issuing site, you can also notify license 

registration to the agency.

You can enter information for email notification in the online license registration 

window.

FULL Execut
e

Manag
ement

To send email notification of license registration 
to distributor, check the “E-mail notification to 
the agency” check box, and enter the e-mail 
address of the agency, user name, and company 
name.

*For details, refer to "3.13.3 Node-locked License ■ Online License Registration" in the included Operation Manual (WinActor_Operation_Manual).
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Notes on Improvement2

The following describes the notes on improvement in Ver. 7.5.0.
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Notes on Improvement (1/2)

Following are notes on improvements made in Ver. 7.5.0.

① Expansion of clickable elements in browser auto-recording

During auto-recording using Edge/Chrome/Firefox browsers, the range of clickable elements has been 

improved. As a result, it is now possible to record clicks even for elements of web pages for which click 

operations could not be recorded, making it easier to create scenarios.

Along with this improvement, web page elements that were not automatically recorded in previous 

version may also be recorded. To avoid recording unintended operations, please be careful not to 

perform unnecessary clicks during auto-recording.

② Support for disabling operations on hidden/inactive items by browser extensions

When using browser extensions to perform browser operations, we fixed operations to be disableｄ on 

hidden/inactive items. If you used the following library in browser extensions to create a scenario for 

manipulating hidden/inactive items, you need to modify the scenario.

23_ browser-related ¥03_ click ¥click, 23_ browser-related ¥property value acquisition,

23_ Browser-related ¥Set property value, 23_ Browser-related ¥Get attribute value,

23_ Browser-related ¥Set attribute value, 23_ Browser-related ¥Get value, 23_ Browser-related ¥Set 

value
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Notes on Improvement (2/2)

③ Initial value change of Option menu (*)

For smooth scenario editing, some of the initial values 

of the option screen have been revised, when 

WinActor is started for the first time.

■Record tab

“Simplify WinActor window whe recording”

Initial value Check OFF → Check ON

■Edit tab

“Hide WinActor when selecting target window"

Initial value Check OFF → Check ON

④ Change the initial value of the scenario information

Some of the initial values in the Scenario Information 

have been revised, when a new scenario.

■Misc. tab

Restrict the number of characters for variables values

Initial value Check ON → Check OFF

*In an environment where WinActor is already used, the settings will be inherited and will not be affected.
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List of Improvements and Requests3

This section describes the list of improvements and requests made in Ver. 7.5.
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List of improvements and requests

The list of improvements (36 requests) made in Ver. 7.5.0

is described in "WinActor _v750_ List of improvements .pdf". (*)

The list of requests (2 requests) that were handled in Ver. 7.5.0 is

described in "WinActor _v750_ List of requests .pdf". (*)

In addition, apart from the above list, the messages displayed in WinActor, WinActor Storyboard and the 

manual have been revised to make them easier to understand.

(*) Note: the pdf is provided only in Japanese version.
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Copyright(c) 2024 NTT Corp. & NTT Advanced Technology Corp. All Rights Reserved.

This manual is protected by copyright laws. Any copying or reproduction of this manual, either in part or its entirety, is 

forbidden.

The contents of this manual are subject to change without notice.
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